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INTRODUCTION

What is an API Endpoint? An APl endpoint is a point at which an application program interface (API) -- the
code that allows two software programs to communicate with each other -- connects with the software
program. APIs send requests for information from a web application or web server and receive a response.

In other words, APl endpoints are the specific digital locations where requests for information are sent by one
program to retrieve the digital resource that exists there. Endpoints specify where APIs can access resources
and help guarantee the proper functioning of the incorporated software.

This document intends to show how to connect and use Strata API as an interface where users can
extract/insert raw data without any graphical user interface.

We need to provide the APl with our Strata login details to access Strata data and retrieve an access token.
Once we have the access token, this will act as an access code and authorise our APl access.

Even though you may have access to more than one Strata (e.g. for different organisations), the API will allow
access to each once you are authenticated. Connecting to each will issue a different access token, valid for
seven days for security reasons.

© Cotopaxi Ltd. Strata API



CONNECTING TO THE STRATA API

To start using the APl and retrieve your access token, you have two options:

USER INTERFACE (Basic)
By using your web browser and going to https://api.strata-login.com

e Fill in the form with your Strata email and password.

Strata Email

Strata Password

e Select the Strata you would like to access.

Strata_Example v

Login To Get a Token

Go Back
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CONNECTING TO THE STRATA API

° Your access token and details will show like the form below.

° On this page, you can copy your token by clicking on the copy button by the token.
° Use this access token as the authorisation header for any request you are sending.
° The refresh token could be used to obtain a new token. Each refresh token is valid for 21 days, and upon

using the refresh token, a new token and a new refresh token will be generated.

f © Cotopaxi Ltd. Strata API

Strata_Example

Login To Get a Token

Refresh Token:

Expiry Date:
2022-02-23

Issued Date:
2022-02-16

Username:

Ramtin.Golkar@cotopaxienergy.com




CONNECTING TO THE STRATA API

USING TOOLS LIKE POSTMAN (Advanced)

This will allow you to consume the API without using a user interface to get the access token.

If you need to see which Strata databases you have access to, send a POST request to:
https://api.strata-login.com/api/Account/GetAccessibleDatabaselList
as the image below with your Strata username and password.

POST v https://api.strata-login.com/api/Account/GetAccessibleDatabaseList Send %

Params Authorization Headers (8) Body @ Pre-request Script Tests Settings Cookies
none form-data @ x-www-form-urlencoded raw binary GraphQL
KEY VALUE DESCRIPTION ooo  Bulk Edit
username ramtin.golkar@cotopaxienergy.com
password examplePassword

You can see in the response an array of objects called “UserDbs”, which will show accessible
Strata.

When you know which Strata you want to connect, pass that to the below POST request with
your username, password and strataDB:

POST v https://api.strata-login.com/api/Account/Login

Params Authorization Headers (8) Body @ Pre-request Script Tests Settings Cookies
none form-data @ x-www-form-urlencoded raw binary GraphQL
KEY VALUE DESCRIPTION ooo  Bulk Edit
username ramtin.golkar@cotopaxienergy.com
password examplePassword
StrataDB Strata_Example

The response will return your access token, which will be used to make requests and be valid
for seven days.

You could avoid the first step if you already know which Strata you want toconnect to, for
example, Strata_(Replace Client Name).
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CONNECTING TO THE STRATA API

Refreshing the access token

Strata API can generate new tokens by passing the refresh token obtained in the previous

login step.

Each refresh token can be used once. As soon as you refresh your access token, a new
refresh token will also be returned, which could be used to refresh the access token again.

You need to pass your refresh token in the body of the request like below:

‘ POST v https:/fapi.strata-login.com/token

=

Params Autherization Headers (8)

Body ® Pre-request Script Tests Settings Cookies

none form-data @ x-www-form-urlencoded

Key
refresh_token
grant_type

StrataDB

Body Cookies Headers (14) Test Results

Pretty Raw Preview Visualize

i

"access_token":

[

JSON v

binary GraphQL
Value Description === Bulk Edit
ee20194e-5112-492d-9009-6440045bchd6
refresh_token

Strata_Example

@ Status: 200 OK Time: 161ms Size: 917B  [) Save as example

@ Q
I

"ObTFHUKECWQ1imzEZx64mXU4AdkYTEKjOuYExITKd2idgnDInN5113gc1KQdL7KBPOFDIEdRXHZ5uC50 -unwl -dtMMWEXPMy LS61EEhChKXZjg1£16ZMHOZhBwIcY191SKN1dE
2UGIBFVGIZPPR-dwANbp3GeugeuZrshld-yPGIKyYs5YbnvNMID14vEF_KkYzMkws3biifmCTey00s4ddq115jPkFc3823B892zMQL21b]IEXE7 - cvvLZRPAMbZAcbMXxgosAEER

993210U19VuUI8sBLWIK_DT7NE_8yZwHIcQ",

"token_type": "bearer”,
"expires_in": 684799,

"userID": null

D0 e W
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"refresh_token": "c573afab-1320-4805-b015-c481255accas",
"usexName": "ramtin.dolkar@cotopaxienexrgy.com”,
".issued": "2023-11-01T10:43:30.0000000+00:00",

" expires": "2023-11-08T10:43:30.0000000+00:00",



CONNECTING TO STRATA APl WITH POWER BI

We can use Power Bl to create custom visualised reports by extracting the data from the Strata
API.

WIZARD

If you want to use the wizard option, follow the steps below.

° From the “File” menu, select “Get Data”.
® L]

New Get data

Open report Quic

Most Common
Savg ions Sensitivity

Save as

[E Excel workbook
Get data

Import ﬁ% Power Bl datasets

Export

EE_.; Power Bl dataflows

Publish
Options and settings [% SQL Server database

Get started
I:I% Azure Analysis Services database

[‘% Text/CSV

[‘?@ Web

° In new versions, click on “Web” as shown in the screenshot above; otherwise, click on
“Other” then select “Web”.
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CONNECTING TO STRATA API WITH POWER BI

1. Select the “Advanced” option here and fill the form with the requested URL in the
1st box as shown below. The URL would be the endpoint you want to access; the
most common URL is for getting data from a datafeed: Click Here

In the above example, put your desired DatafeedID after the equal sign, as in
the picture below.

Tip: When you are viewing a data feed in Strata. The last part is your data
feed ID. (in this example 16001)

a3 example.strata-login.com

Type in a header called “Authorization” in the 2nd box. Then, in the 3rd box, type
“bearer”, add one space after and paste your access token, which you obtained
from the previous steps.

From Web

O Basic ® Advanced

URL parts ()
[https://api.strata—Iogin.com/api/Strata/GetDataTrend?DataFeedlD=16001@ < 1st

URL preview
https://api.strata-login.com/api/Strata/GetDataTrend?DataFeedID= 160018

Command timeout in minutes (optional)

HTTP request header parameters (optional)

(Authorization ﬁ‘ (bearer QCIhkaEvszveOfUYOOOMkZza
A~ A
2nd 3rd

Sl [ ]
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https://api.strata-login.com/api/Strata/GetDataTrend?DataFeedID=%E2%80%9DReplaceWithYourDataFeedID%E2%80%9D&StartDate=2021-01-01&EndDate=2021-12-01

CONNECTING TO STRATA API WITH POWER BI

Pressing ‘OK’ will return the data.

> fx = Table.ExpandRecordColumn(#"Converted to Tablel”, “"Columnl”, {"Reading”, "EndReading”, "OwerrideReading”, "Consumption”, "MaxConsumption®”, "MinConsumption”, v
PN (55 columniReading  [Bll|135 Columni.endReading [R|{55 columni.overridereading [Ell|155 columni.consumption [El|155 columni.maxconsumption [Bll|135 columni.minconsumption Rl 135 columni.cost
2
g 1 378281.578 o o 378281.578 525.071 o A
€ 2 718475.862 o 0 718479.862 529.348 473.056

3 708315.474 0 0 708315.474 525.765 443.026

4 718914.905 o 0 718914.905 527.074 474.433

5 718452.23 o 0 718452.23 539.24 470.757

6 724445.412 o o 724449.412 528693 475.478

7 795612.114 o 0 795612.114 664.478 478.285

8 726610.414 0 0 726610.414 534.819 480.029

9 722104.36 o 0 722104.36 552.467 477.097

10 702481.123 o 0 702481.123 531.733 459.993

11 704825.369 o o 704825.369 535.692 460.993

12 716828.43 o 0 716828.43 535.499 472.142

13 722918.36 0 0 722918.36 525.048 474.422

14 721523.719 o 0 721523.719 532.307 471.295

15 724368.062 0 0 724968.062 585.453 478.161

16 792730.176 o 0 752730.176 645.161 481.018

17 710454.678 o 0 710454.678 525.05 473.981

18 718130.465 o 0 718130.465 524.995 474.646

19 726833.71 o o 726833.71 542.88 479.377

20 7268832.037 0 0 726883.037 539.832 443.038

21 722743.878 o 0 722745.878 537.578 476.098

22 724472.855 o 0 724472.855 531.113 480.161

23 726502.87 o o 726502.87 541.853 479.562

24 718427.184 o o 718427.184 533.563 478.537

25 723655.512 0 0 722653.512 548.124 476.462

26 713753.726 o 0 713753.726 525.295 452.566

27 170244.554 o 0 170244.554 527.13 473.937

28 211778.0167 o 0 211778.0107 221.646 21.8219

29 408228.141 o o 408228.141 541.061 161.697

30 499377.473 o 0 499377.473 385.177 320.793

31 451430.327 o o 451430.327 389.27 186.148 (V]

32 < 264923.656 o 0 264923.656 253.561 165.898 >
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ADVANCED POWER BI SCRIPT EXAMPLE

USING ADVANCED QUERY
Here is an example: https://api.strata-login.com/Content/PowerBIQueryExample.txt

Use this example to log in by providing your Strata credentials, retrieving the data from different
data feeds, and combining those results. You could use the example to call other endpoints by
simply following the same format as the example.

To use this, you need to go to “File” => “Get Data” => “Blank Query”, then from the left-hand
side, right-click on the new query (usually called “Query 1”) and select “Advanced Query”, then
paste the above example.

let

baseURL = "https://api.strata-login.com/api/™,
body =

Username place Strata Username”,
Password Replace Strata Password”,
SstratabB "Strata_[ClientName]™

1,

login =Json.Document (Web.Contents(baseURL& account/login™,[Content = Text.ToBinary(Uri.BuildQueryString(body)),Headers = [#"Content-Type"="application/x-www-form-urlencoded”]])),
Access_token = login[Access_token],
//startdate set to 7 days ago and end date is current date

startDate = DateTime.ToText(Date.AddDays(DateTime.LocalNow(),-7), “yyyy-MM-dd"),
endDate = DateTime.ToText(DateTime.LocalNow(), "yyyy-MM-dd"),

//Add as many Source as you need (e.g: sourcel,?,3,4,5) and just change the DatafeedID like below example -- Aggregation is now weekly 604800 seconds = 1 week
Sourcel = Json.Document(Web.Contents("https://api.strata-login.com/api/strata/GetDataTrend?DataFeedID=[DataFeed
ID]&startDate="&startDate&"&EndDate="RendDate&"&AggregationLevel-6048008AggegationType=1", [Headers=[authorization="bearer "&Access_token]])),

Source2 = Json.Document(Web.Contents("https://api.strata-login.com/api/strata/GetDataTrend?DataFeedID=[DataFeed
ID]&startDate="&startDate&"&EndDate="8endDate&"8AggregationLevel-6048008AggegationType=1", [Headers=[authorization="bearer "&Access_token]])),

//this will combine the result if you need
output = List.Combine({Source1,Source2}),
outputl = output{e}

in
outputl
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EXAMPLE OF USING AN ENDPOINT WITH AN
ACCESS TOKEN

Endpoint example: https://api.strata-login.com/api/Strata/GetDataTrend

e Go to the “Authorization” tab, select ‘bearer token’ and

paste the obtained token.

https://api.strata-login.com/api/Strata/GetDataTrend?DataFeedID=4034&StartDate=2021-01-01&EndDate=2021-12-01

GET v
Cookies

Params @ Authorization ® Headers (7) Body Pre-request Script Tests Settings

X

@ Heads up! These parameters hold sensitive data. To keep this data secure while working in a collaborative environment, we

Type Bearer Token v
recommend using variables. Learn more about variables 2

The authorization header will be automatically

generated when you send the request.
Learn more about authorization 2

Token QClhkaEvzfLve0fUYOOOMk2267WJ1P0ZCW

Go to the “Params” tab and add your parameters; in this case, the
data feed ID, start and end date are below.

https://api.strata-login.com/api/Strata/GetDataTrend?DataFeedID=4034&StartDate=2021-01-01&EndDate=2021-12-01

GET v
Params @ Authorization @ Headers (7) Body Pre-request Script Tests Settings Cookies
Query Params
KEY VALUE DESCRIPTION 000 Bulk Edit
DataFeedID 4034
StartDate 2021-01-01
2021-12-01

EndDate
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EXAMPLE OF INSERTING DATA INTO STRATA WITH AN
ACCESS TOKEN

Endpoint example: https://api.strata-login.com/api/Strata/InsertDataFeedReading
e Go to the “Authorization” tab, select “bearer token”,
and paste the obtained token from the previous

steps.
GET v https://api.strata-login.com/api/Strata/GetDataTrend?DataFeedID=4034&StartDate=2021-01-01&EndDate=2021-12-01
Params @ Authorization ® Headers (7) Body Pre-request Script Tests Settings Cookies
Type Bearer Token v (® Heads up! These parameters hold sensitive data. To keep this data secure while working in a collaborative environment, we ¥

recommend using variables. Learn more about variables 7

The authorization header will be automatically

generated when you send the request.
Learn more about authorization 2 Token QClhkaEvzfLve0fUYOOOMk2z67WJ1PoZCW

e Change your method to “POST” and go to the “Body” tab and send your readings like below:

[ POST ¥ | hups://api.strata-login.com/api/Strata/InsertDataFeedReading }(
Params Authorization @ Headers (10) Body @ Pre-request Script Tests Settings
none form-data x-www-form-urlencoded ® raw binary GraphQL JSON
1 A
2 "DataReadinglList": [
3 1
4 "ReadingDate": "2020-@3-25 15:45:40",
5 "Reading": 558@.522
6 Is
7 {
8 "ReadingDate": "2020-83-25 15:46:50",
9 "Reading": 7000.10
10 }
1 1
12 "PKDataFeedID": 1622
13 3}
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API Limits

There are two types of limits on the API:

e Short time limiter:
o 15 seconds for subsequent POST requests
o A second for subsequent GET requests

e An hourly limiter:

o 1000 requests within an hour per user

ALL AVAILABLE ENDPOINTS AND DOCUMENTATION

o To see all the available Strata APl endpoints and their documentation, please Click here.
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https://api.strata-login.com/Help

